Warranty

This version of Well Logger™ software is free, and therefore is not warranted to be fit for any particular use.

Porpoise Media does not make any warranties, express or implied. Every attempt has been made to ensure that the software is fully functional and that the help documentation is accurate and complete. Porpoise Media is not liable for any special, consequential, or other damages for any reason. This includes, but is not limited to, loss of data or delays to your projects.

License Agreement

- This Limited Use Software License Agreement (the "Agreement") is a legal agreement between you, the end-user ("Licensee"), and Porpoise Media. By using this software or storing this program ("Well Logger") on a computer hard drive (or other media), you are agreeing to be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, and you have registered this software, promptly return the software and the accompanying items (including any written materials) within 30 days of purchase, along with your receipt for a full refund; or delete the software from all storage media.

- You may install this program to test and evaluate for 30 days; after that time you must either register this program or delete it from your computer hard drive.

- This software may be distributed freely on online services, bulletin boards, or other electronic media as long as the files are distributed in their entirety. This software may not be distributed on CD-ROM, disk, or other physical media for a fee of more than $15.00 (US) without the permission of Porpoise Media.

- You may not alter this software in any way, including changing or removing any messages or windows.

- You may not decompile, reverse engineer, disassemble or otherwise reduce this software to a human perceivable form. You may not modify, rent or resell for profit this software, or create derivative works based upon this software. You may not publicize or distribute any registration code algorithms, information, or registration codes used by this software without permission of Porpoise Media.

Copyright

Well Logger™ is Copyright Porpoise Media, Long Beach, California with all rights reserved. You must treat the Software like any other copyrighted material.

Well Logger™ registration codes may not be posted on the Internet, nor may they be distributed to anyone except the person or company who purchased a license for Well Logger. Well Logger registration codes are copyright Porpoise Media, Long Beach, California with all rights reserved.

Other

THE SOFTWARE IS PROVIDED TO LICENSEE "AS IS". ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS, AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY, SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

THIS SOFTWARE IS NOT FAULT TOLERANT AND SHOULD NOT BE USED IN ANY ENVIRONMENT WHICH REQUIRES THIS, SUCH AS ON-LINE CONTROL OF AIRCRAFT.

TO THE EXTENT NOT PROHIBITED BY APPLICABLE LAW, PORPOISE MEDIA’S AGGREGATE LIABILITY TO LICENSEE OR TO ANY THIRD PARTY FOR CLAIMS RELATING TO THIS AGREEMENT, WHETHER FOR BREACH OR IN TORT, WILL BE LIMITED TO THE FEES PAID BY LICENSEE FOR SOFTWARE WHICH IS THE SUBJECT MATTER OF THE CLAIM(S). IN NO EVENT WILL PORPOISE MEDIA BE LIABLE FOR ANY INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGE IN CONNECTION WITH OR ARISING OUT OF THIS AGREEMENT (INCLUDING LOSS OF BUSINESS, REVENUE, PROFITS, USE, DATA OR OTHER ECONOMIC ADVANTAGE), HOWEVER IT ARISES, WHETHER FOR BREACH OR IN TORT, EVEN IF PORPOISE MEDIA HAS BEEN PREVIOUSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. LIABILITY FOR DAMAGES WILL BE LIMITED AND EXCLUDED, EVEN IF ANY EXCLUSIVE REMEDY PROVIDED FOR IN THIS AGREEMENT FAILS OF ITS ESSENTIAL PURPOSE.

Technical Support

Support is available online at http://www.porpoisemedia.com or by sending an e-mail to support@porpoisemedia.com.

Trademarks

WINDOWS® and MICROSOFT® are registered trademarks of MICROSOFT, Washington, USA.

WELL LOGGER™ is a trademark of Porpoise Media, Long Beach, California, USA.
Table of Contents

Warranty ......................................................................................................................... i
License Agreement ............................................................................................................ 1
Copyright ......................................................................................................................... i
Other ............................................................................................................................... i
Technical Support ........................................................................................................... ii
Trademarks ...................................................................................................................... ii
Table of Contents ............................................................................................................. iii

CHAPTER 1 - INTRODUCTION ......................................................................................... 1
  Using This Manual ........................................................................................................... 1
  Getting Started ............................................................................................................... 1
  Features .......................................................................................................................... 2
  Preferences .................................................................................................................... 3

CHAPTER 2 - CREATING FILES .................................................................................... 5
  Creating Files .................................................................................................................. 5
  Depth Units ..................................................................................................................... 5
  Lithology Entry .............................................................................................................. 6
  Sample Entry ................................................................................................................. 7
  Completion Entry .......................................................................................................... 8
  Project Information Entry ............................................................................................. 9
  Boring Information Entry ............................................................................................ 10

CHAPTER 3 - LOG LAYOUTS ......................................................................................... 11
  Pre-Defined Layouts ...................................................................................................... 11
  Creating Layouts ........................................................................................................... 11
  Text Entry ..................................................................................................................... 12
  Variables ....................................................................................................................... 13
  Line Entry ..................................................................................................................... 14
  Graphic Entry ............................................................................................................... 15
  Graphic Column Entry ................................................................................................ 15
  Graphic Column Types ............................................................................................... 16
  Options Entry ............................................................................................................... 16

CHAPTER 4 - EDITING FILL PATTERNS ..................................................................... 17
  Classification Pattern Files .......................................................................................... 17
  Creating Fill Patterns ................................................................................................... 18

CHAPTER 5 - PRINTING .................................................................................................. 19
  Printing .......................................................................................................................... 19
  Print Preview ................................................................................................................ 19
  Print Options ................................................................................................................ 20

GLOSSARY ..................................................................................................................... 21

Appendix A ...................................................................................................................... Layout Forms
Appendix B ...................................................................................................................... Patterns
CHAPTER 1 - INTRODUCTION

Using This Manual

This manual assumes that you are familiar with the Windows operating system (Windows XP, Vista, 7, or 8) and basic data entry and file management skills. If you need assistance in these areas, please reference your Windows documentation.

This manual is divided into five major sections including this introductory chapter to get you started, a chapter on creating new files (Chapter 2), a chapter on creating and editing layouts (Chapter 3), a section on creating and editing fill patterns (Chapter 4), and a section on printing logs (Chapter 5). A glossary is included at the end of this manual so that you can reference any terms that you are not familiar with.

We suggest that you read the entire manual to become familiar with all of the features of Well Logger™ so that you can use it to its full potential.

Getting Started

To install the Well Logger™ software, insert disk number one of the installation disk series and execute the program named Setup.exe. Setup.exe will guide you through the installation process.

The first time you run Well Logger™, a registration screen will appear. In this screen, enter the name of the user or the department that is using Well Logger™. Also enter your company name and registration code. Without the registration information entered, Well Logger™ will run in “Demo Mode.”

After registering Well Logger™, choose Select Layout Form from the File menu. It will be necessary for you to choose a layout before being able to print any files that you create (see Appendix A for examples of layouts included with Well Logger™).
Features

Some of the features in Well Logger™ include:

- Easy-to-use spreadsheet interface with drop-down boxes for simplifying data entry of each borehole. Entry information includes borehole lithology, samples collected, well construction or borehole backfilling details, and general information about the project and boring.

- Flexible, easy-to-create, user-definable print layouts for use with virtually any printer. Pre-defined layouts are also included to get you started quickly.

- User-definable fill patterns for lithology, sample type, and well construction graphics. Unified Soil Classification System (USCS) and other geological and industrial fill patterns are included.

- Over 70 variables (e.g. Page Number, Site Address, Project Supervisor, etc.) can be included in the page layouts you create.

- Ten user-definable columns for including geotechnical properties, chemical concentrations, or other characteristics of soil samples.

- Adjustable scaling to allow for changing the number of depth units printed on a page.

- Copy logs to Enhanced Windows Metafiles (EMFs) and paste them into your favorite graphics program for editing.

- On-screen print preview.
Preferences

Setting preferences is easy. Select “Edit” from the program menu and choose “Preferences.” A dialog box with three tabs will appear. One tab is used for entering information about your company that can appear on the printed log through the use of layout variables (See Chapter 3). The second tab is used for entering the default User-Defined Variables, which are used for sample headings (See Chapter 2). The third tab is used to select default paths for saving and opening data and layout files.

Preferences screen for entering company information.
Preferences screen for entering default User-Defined Variables.

Preferences screen for entering default File and Layout directories.
Creating Files

To create a new file, select New from the File menu within Well Logger™. You will be requested to enter the name of the file you would like to create. If you create a file while another file is opened, the opened file’s data will be saved due to Well Logger™’s “Save-As-You-Go” feature.

A screen will appear that will display a spreadsheet with five tabs above it, as illustrated in the following section. This screen is to be used for entry of boring log information. The tab choices are:

- Lithology
- Samples
- Completion
- Boring Info.
- Project Info.

These tabs are described in the following sections.

Depth Units

The depths described by the To and From columns in the Lithology, Sample, and Completion Entry forms use the values entered into the Depth Units field of the Boring Info. screen. The Depth Units field is also used for other depth measurements such as Ground Elevation, Total Depth, and Static Water Level.

It is recommended that depth units be set in the Boring Info. entry screen.
Lithology Entry

The lithology entry screen contains five fields: **To, From, Description, Classification, and Line Type.** **To** and **From** indicate the depths of the interval being described. **Description** describes the sediments or rock type in the interval. **Classification** puts the sediment or rock type into a category that tells Well Logger™ which fill patterns to use in the Lithology graphic column. The **Line Type** field tells Well Logger™ what type of line to print beneath the text in **Description.**
Sample Entry

The sample entry screen contains fourteen fields: From, To, Sample Type, Blow Counts, and ten User Fields. To and From describe the depths of the interval being described. Sample Type tells Well Logger what type of fill pattern to use to represent the sample interval. Blow Counts is a record of the number of Blow Counts collected in an interval. The User Fields can be used to represent any type of characteristic of a sample. The figure above demonstrates using these fields to represent organic vapor analyzer (OVA) reading concentrations. These fields can be used for chemical concentrations, geotechnical characteristics, or virtually anything you wish.

To change the heading of a user column, select "Sample Headings" from the Edit menu or "right-click" on the heading of the column you wish to change.
Completion Entry

The completion entry screen contains three fields: To, From, and Classification. To and From indicate the depths of the interval being described. Classification represents the material(s) used in backfilling the borehole or in well construction.

This screen also contains a Completion Notes field, which can be used to enter notes about the log.
Project Information Entry

This screen includes data fields for the entry of values related to the boring log being created. The values entered into these fields can be used with variables in a layout file (see Chapter 3 for more details about variables).

Note: Data fields that do not contain data will be represented by a blank space if their corresponding variables are used in a layout file.
Boring Information Entry

This screen includes data fields for the entry of values related to the boring log being created. The values entered into these fields can be used with variables in a layout file (see Chapter 3 for more details about variables).

Note: Data fields that do not contain data will be represented by a blank space if their corresponding variables are used in a layout file.
CHAPTER 3 - LOG LAYOUTS

Pre-Defined Layouts

Several pre-defined layouts come with Well Logger™. You can use one of these layouts, or you can easily design your own. If you decide that you would like to modify an existing layout, it is suggested that you make a copy of the existing layout file and work with it so that you do not alter the original file. See Appendix A for examples of pre-defined layouts.

If you decide to use an existing layout, it will be necessary for you to change the provided logo with your own logo (if the layout you choose contains a graphic). For details, see the section “Graphic Entry” later in this chapter.

Creating Layouts

When creating your own layouts, it is suggested that you draw the layout by hand onto a piece of engineer scale (10 squares to an inch) graph paper before entering information into Well Logger™. This will make it easy to transfer the data into your custom layout file.

To create a new layout template file, select Create New Layout from the Layout menu within Well Logger™. You will be requested to enter the name of the file you would like to create. The new layout file will be selected as the active layout file.

A screen will appear that will display a spreadsheet with five tabs above it. This screen is to be used for entry of the layout information. The tab choices are:

- Text
- Lines
- Graphics
- Columns
- Options

These tabs are described in the following sections.
Text Entry

The text entry screen contains thirteen fields: Text, X, Y, XX, YY, Font, Size, Bold, Italic, Underline, Color, Alignment, and Angle. Text describes what type of text to print. This text can be user entered, or a variable can be selected from a drop-down combo box (see the next section for a description of variable usage).

X, Y, XX, and YY are the coordinates (in inches) of where to place text. To have text placed about a single point, set XX and YY equal to zero and have the text placed about the point X, Y. The text will be justified about the point X, Y according to the setting under Alignment. To have text displayed within a square region, use X and Y as the upper-left coordinates of the region and XX and YY as the lower-right coordinates of the region.

Font, Size, Bold, Italic, Underline, and Color describe characteristics of the text. Alignment determines how the text is aligned (Left, Center, or Right). The Angle field is used for rotating text. Horizontal text is at 0°. Using a number between 0° and 360° in the Angle field will rotate text in a counter-clockwise direction.
Variables

Variables are used within the text section of a layout file to place data from Well Logger™ entry fields onto the printed page. When editing a layout file, a drop-down combo box is available for easy selection of a variable.

Available variables are:

```
<<Boring Diameter>>
<<Boring Diameter Units>>
<<Boring Diameter>> + <<Boring Diameter Units>>
<<Boring Name>>
<<Case Number>>
<<Client>>
<<Client Contact>>
<<Client Address 1>>
<<Client Address 2>>
<<Client City>>
<<Client City>> + <<Client State>>
<<Client Contact>> + <<Client State>> + <<Client Zip>>
<<Client Phone>>
<<Client State>>
<<Client Zip>>
<<Common Well Name>>
<<Company Address>>
<<Company City>>
<<Company City>> + <<Company State>>
<<Company City>> + <<Company State>> + <<Company Zip>>
<<Company Country>>
<<Company Name>>
<<Company State>>
<<Company Zip>>
<<Completion>>
<<Date End>>
<<Date Start>>
<<Depth Units>>
<<Drill Method>>
<<Drill Rig>>
<<Drilled Water>>
<<Drilled Water>> + <<Depth Units>>
<<Driller>>
<<Drilling Contractor>>
<<Eastings>>
<<Eastings>> + <<Eastings Units>>
<<Eastings Units>>
<<Facility Number>>
<<Facility Well Name>>
<<File Name>>
<<File Path>>
<<Ground Elevation>>
<<Ground Elevation>> + <<Depth Units>>
<<Ground Elevation>> + <<Depth Units>>
<<Latitude>>
<<Lead Agency>>
<<License Number>>
<<Location Code>>
<<Longitude>>
<<Northing>>
<<Northing>> + <<Northing Units>>
<<Northing Units>>
<<Page Number>>
<<Page Number>>
<<Plunge>>
<<Potentiometric Water>>
<<Potentiometric Water>> + <<Depth Units>>
<<Print Date>>
<<Print Date>> + <<Print Time>>
<<Print Time>>
<<Print Time>>
<<Project Name>>
<<Project Number>>
<<Qtr Section Primary>>
<<Qtr Section Secondary>>
<<Range>>
<<Range Direction>>
<<Section>>
<<Site Address 1>>
<<Site Address 2>>
<<Site City>>
<<Site City>> + <<Site State>>
<<Site City>> + <<Site State>> + <<Site Zip>>
<<Site State>>
<<Site Zip>>
<<State Plane Easting>>
<<State Plane Northing>>
<<State Plane Easting>>
<<State Plane Northing>>
<<State Well Name>>
<<Static Water>>
<<Static Water>> + <<Depth Units>>
<<Supervisor>>
<<Total Depth>>
<<Total Depth>> + <<Depth Units>>
<<Township>>
<<Township Direction>>
<<Trend>>
<<User 1>> through <<User 10>>
<<USGS Location>>
```

The variables listed above are used with entry fields from the Project Info. and Boring Info. entry screens that are described in Chapter 2. Exceptions are the values marked with a star (*). These values are determined by Well Logger™.
Line Entry

The line entry screen contains seven fields: X, Y, XX, YY, Line Type, Line Width, and Line Color. X, Y, XX, and YY describe the coordinate of the line (in inches) where X, Y is one coordinate of a line and XX, YY is the other coordinate of the line. Line Type, Line Width, and Line Color describe properties of the line.
## Graphic Entry

The graphic screen contains five fields: X, Y, XX, YY, and Graphic File Name. X, Y, XX, and YY describe the coordinates of where to place a graphic image (such as a logo). The Graphic File Name field describes the path of the file to use as a graphic. The graphic file should be a bitmap (.bmp or .dib) that is created at a size two to three times larger than planned for display. For example, on line one of the entry screen above, the display size of the Graphic File (Logo.bmp) is 2 inches wide by 1 inch tall. We suggest that the actual size of your logo image be 6 inches by 3 inches (3 times larger than the display size). This will enhance the final output of the image.

## Graphic Column Entry

The columns entry screen contains fourteen fields: Column Type, X, Y, XX, YY, Font, Size, Bold, Italic, Underline, Color, Line Type, Line Width, and Line Color. Column Type describes what type of column to print. X, Y, XX, and YY are the coordinates (in inches) of where to put the column. It is recommended that all Y values are the same for all columns and that all YY values are the same for all columns. Font, Size, Bold, Italic, Underline, and Color describe characteristics of text to use in a column. These properties are ignored if text is not printed in a column, such as with Lithology and Completion columns. Line Type, Line Width, and Line Color describe characteristics of the lines drawn in the columns. Line Width is ignored for use in the Description column due to restrictions imposed by the operating system.
Graphic Column Types

The Graphic Column types available are:

- Classification
- Completion
- Depth
- Description
- Blow Count
- Sample Symbol
- Lithology
- User Text Types

Options Entry

This screen includes data fields for the entry of formatting information for the boring log layout being created. The fields on this screen are:

- Truncate Upper Column Text
- Truncate Lower Column Text

If selected, these options will eliminate text from either the upper or lower portion of the depth column when printed. This feature is useful if your layout is designed so that there is a horizontal line placed in the location where the text would otherwise be placed.
CHAPTER 4 - EDITING FILL PATTERNS

Classification Pattern Files

To edit Classification Pattern Files, select Edit Classifications from the Classifications menu item. This option is only available if there are no other files open within Well Logger™.

The Pattern Files field in the Lithology, Completion, and Sample fields requires entry in a specific format:

\[ \text{file:percentage [:file:percentage] [:file:percentage]} \ldots \]

where file is the name of a bitmap image that is to be used in the fill pattern and percentage is the percentage of the column width to be filled by file. The items in brackets are optional. Be careful to ensure that the sum of the percentage parameters equals 100.

The data in line four (above) was used to create the upper portion of the column in the image below, which represents a single blank casing that has bentonite backfilled around it. The data in line two was used to create the portion below this, which represents a single blank casing that has sand backfilled around it. The data in line three represents the bottom-most portion of the image below. This represents a single screened casing that is backfilled with sand.
Creating Fill Patterns

The Lithology, Completion, and Sample classification tabs shown above each contain columns for entry of a Description and for Pattern Files. The Description column contains data that is displayed during editing and creation of well and boring logs in a drop-down combo box for the respective field. The Pattern Files column contains formatted data about which graphic files are to be used in displaying the fill pattern.

For example, in row number one above, the description that would be displayed in the spreadsheet's drop-down combo box while creating a Well Logger™ file would be "GW". The image that would be displayed for this code is GW.DIB. The image in GW.DIB would fill 100% of the width of the column it is displayed in.

You can generate your own bitmaps for use as fill patterns with Well Logger™, if you wish. The bitmap (.bmp or .dib) patterns should be created at a size larger than you would like to have them printed. Well Logger™ will scale the size of the original bitmap by the setting under Print Options. This is done to enhance the resolution of the bitmapped image and to improve final print quality.
CHAPTER 5 - PRINTING

Printing

To print files, select Print from the File menu. If you prefer to preview a Well Logger™ document on the screen, then select Print Preview from the File menu.

To select the printer for output, or additional printer properties such as page orientation (if your printer supports this option), select Print Setup from the File menu.

Print Preview

To preview a file, select Print Preview from the File menu. The preview screen will allow you to change which page is being viewed and to zoom in or out on the current page.
Print Options

The Print Options screen appears prior to printing to the printer, or prior to a print-preview action. This screen accepts values for Units Per Page, Pattern Scale Factor, Major Tick Interval, Minor Tick Interval and Number of Copies.

Major Tick Interval is a value that determines the interval at which major tick marks will be printed on the depth column. This must be set to an integer value. Minor Tick Interval is a value that determines the interval at which minor tick marks will be printed on the depth column. This must be set to an integer value that can be evenly divided into the value set for Major Tick Interval. Number of Copies tells Well Logger™ how many copies of the boring log to print.

To change or configure the current printer, click on the button displaying the current printer’s name, located at the top of the Print Options screen. To select a layout to be used, click on the button in the First Page Layout File section of the screen. If you wish to use a different layout for additional pages, select Use “Additional Pages” Layout File and click on the button in the Additional Pages Layout File section to choose a layout.

The user can also choose to print more than one boring from a project from this screen, allowing you to print your entire project with a single print command.

Note: When using Print-Preview, only the current boring can be previewed. The option of multiple boring selections is not available for Print-Preview actions.
GLOSSARY

Boring Diameter

The Well Logger™ variable for this field is: <<Boring Diameter>>.
To include Boring Diameter units, use <<Boring Diameter>> + <<Boring Diameter Units>>.

Boring Diameter Units

The Well Logger™ variable for this field is: <<Boring Diameter Units>>.

Boring Name

The name of the boring or well described with the Well Logger™ file.

The Well Logger™ variable for this field is: <<Boring Name>>.

Case Number

If your site is under regulatory review, this field is useful for including a reference to the regulator’s case number on your boring logs.

The Well Logger™ variable for this field is: <<Case Number>>.

Classification Description

The Description in the Lithology, Completion, and Sample fields of the Classification edit screen is the text that is displayed in the Well Logger™ file entry drop-down boxes for classification of Lithology, Completion, and Samples.

Client

The Well Logger™ variable for this field is: <<Client>>.

Client Address

There are two fields for entry of the client’s address.

The Well Logger™ variables for these fields are: <<Client Address 1>> and <<Client Address 2>>.

Client City

The Well Logger™ variable for this field is: <<Client City>>.

Client Contact

The Well Logger™ variable for this field is: <<Client Contact>>.

Client Phone

The Well Logger™ variable for this field is: <<Client Phone>>.

Client State

The Well Logger™ variable for this field is: <<Client State>>.

Client Zip

The Well Logger™ variable for this field is: <<Client Zip>>.

Common Well Name

The Well Logger™ variable for this field is: <<Common Well Name>>.
Company Address

The Well Logger™ variable for this field is: <<Company Address>>.

Company City

The Well Logger™ variable for this field is: <<Company City>>.

Company Country

The Well Logger™ variable for this field is: <<Company Country>>.

Company Name

The Well Logger™ variable for this field is: <<Company Name>>.

Company State

The Well Logger™ variable for this field is: <<Company State>>.

Company Zip

The Well Logger™ variable for this field is: <<Company Zip>>.

Completion

The Well Logger™ variable for this field is: <<Completion>>.

Dates Drilled

There are two fields for the dates drilled -- One for the date the boring advancement began and one for when it ended.

The Well Logger™ variables for this field are: <<Date Start>> and <<Date End>>.

Depth Units

The Well Logger™ variable for this field is: <<Depth Units>>.

Drill Method

The Well Logger™ variable for this field is: <<Drill Method>>.

Drill Rig

The Well Logger™ variable for this field is: <<Drill Rig>>.

Drilled Water

The Well Logger™ variable for this field is: <<Drilled Water>>.
To include depth units, use: <<Drilled Water>> + <<Depth Units>>.

Driller

The Well Logger™ variable for this field is: <<Driller>>.

Drilling Contractor

The Well Logger™ variable for this field is: <<Drilling Contractor>>.

Easting

The number of units east of a reference point that the well is located. If the well is located west of the said reference point, then use a negative number.

The Well Logger™ variable for this field is: <<Easting>>.
To include depth units, use <<Easting>> + <<Easting Units>>.
Facility Number

The Well Logger™ variable for this field is: <<Facility Number>>.

Facility Well Name

The Well Logger™ variable for this field is: <<Facility Well Name>>.

File Name

The Well Logger™ variable for this field is: <<File Name>>.

File Path

The Well Logger™ variable for this field is: <<File Path>>.

Fill Patterns

There are a variety of fill patterns that come with Well Logger™, including fill patterns for use with the Unified Soil Classification System (USCS). Additional fill patterns can be easily created by the end user.

Ground Elevation

The Well Logger™ variable for this field is: <<Ground Elevation>>.
To include depth units, use <<Ground Elevation>> + <<Depth Units>>.

Latitude

The Well Logger™ variable for this field is: <<Latitude>>.

Layout File

Layout files are used by Well Logger™ to determine how to display output. The extension for a layout file is .wlf.

Lead Agency

The Well Logger™ variable for this field is: <<Lead Agency>>.

License Number

The drilling contractor’s license number.

The Well Logger™ variable for this field is: <<License Number>>.

Location Code

The Well Logger™ variable for this field is: <<Location Code>>.

Longitude

The Well Logger™ variable for this field is: <<Longitude>>.

Major Tick Interval

This value is used to determine the interval at which major tick marks are printed on the depth column. This must be set to an integer value.

Minor Tick Interval

This value is used to determine the interval at which minor tick marks are printed on the depth column. This must be set to an integer value that can evenly be divided into the value set for Major Tick Interval.
**Northing**

The number of units north of a reference point that the well is located. If the well is located south of the said reference point, then use a negative number.

The Well Logger™ variable for this field is: <<Northing>>.
To include Northing units, use <<Northing>> + <<Northing Units>>.

**Page Number**

This variable is used to print the page number of the output to the page.

The Well Logger™ variable for this field is: <<Page Number>>.

**Pattern Scale Factor**

This value is used in determining what scale to print fill patterns at. The default value is 0.333. This means that the original graphics used as fill patterns will be printed at 1/3 (or 0.333 times) the original size. The user can adjust this value to change the resolution of the output and to scale the fill patterns.

It may be necessary with certain printers to adjust this value to avoid errors in bitmap scaling.

**Plunge**

See Trend and Plunge

**Potentiometric Water Level**

The Well Logger™ variable for this field is: <<Potentiometric Water>>.
To include depth units, use <<Potentiometric Water>> + <<Depth Units>>.

**Print Date and Time**

These variables will print the date and time at which a log is printed.

The Well Logger™ variables for these fields are: <<Print Date>> and <<Print Time>>.
To print both the date and time, you may combine these fields to form: <<Print Date>> + <<Print Time>>.

**Project Name**

The Well Logger™ variable for this field is: <<Project Name>>.

**Project Number**

The Well Logger™ variable for this field is: <<Project Number>>.

**Quarter Sections**

The Well Logger™ variables for these fields are: <<Qtr Section Primary>> and <<Qtr Section Secondary>>.

**Range/Range Direction**

The Well Logger™ variables for these fields are: <<Range>> and <<Range Direction>>.

**Save-As-You-Go**

All files within Well Logger™ are saved as they are created, much like many popular database applications. This feature significantly reduces the possibility of lost data.

**Section**

The Well Logger™ variable for this field is: <<Section>>.
Site Address

There are two fields for entry of the site address.

The Well Logger™ variables for these fields are: <<Site Address 1>> and <<Site Address 2>>.

Site City

The Well Logger™ variable for this field is: <<Site City>>.

Site State

The Well Logger™ variable for this field is: <<Site State>>.

Site Zip

The Well Logger™ variable for this field is: <<Site Zip>>.

State Plane Easting/Northing

The Well Logger™ variables for these fields are: <<State Plane Easting>>.

State Well Name

The Well Logger™ variable for this field is: <<State Well Name>>.

Static Water Level

The Well Logger™ variable for this field is: <<Static Water>>.
To include depth units, use <<Static Water>> + <<Depth Units>>.

Supervisor

The name of the Supervisor (field or project supervisor) for the construction of the boring or well.

The Well Logger™ variable for this field is: <<Supervisor>>.

Total Depth

The Well Logger™ variable for this field is <<Total Depth>>.
To include depth units, use <<Total Depth>> + <<Depth Units>>.

Township/Township Direction

The Well Logger™ variables for these fields are: <<Township>> and <<Township Direction>>.

Trend and Plunge

These variables indicate the trend and plunge that a boring was advanced upon. Trend is indicated in degrees relative to north (e.g., 0° is north, 90° is east, etc.). Plunge is indicated in degrees from vertical (e.g., 0° is vertical and 90° is horizontal).

The Well Logger™ variables for these fields are <<Trend>> and <<Plunge>>.

Truncate Lower Column Text

If selected, this option will eliminate the lower text of the depth column from being printed. This feature is useful if your layout is designed so that there is a horizontal line placed in the location where the text would otherwise be placed.

Truncate Upper Column Text

If selected, this option will eliminate the upper text of the depth column from being printed. This feature is useful if your layout is designed so that there is a horizontal line placed in the location where the text would otherwise be placed.
Unified Soil Classification System

A standardized system of classifying soils that is commonly accepted in the geological industry.

Units Per Page

This entry field determines how many units will be printed on a page. If the total depth of a well or boring is 58 units and 40 units are printed on a page, then the Well Logger™ output will be a total of 2 pages.

User 1

There are ten user variables. These are the values for the headers in the user-defined columns in the sample entry tab.

The Well Logger™ variables for these fields are: <<User 1>>, <<User 2>>, <<User 3>>, <<User 4>>, <<User 5>>, <<User 6>>, <<User 7>>, <<User 8>>, <<User 9>>, and <<User 10>>.

User Sample Entries

User Sample Entries are used in the User columns within Well Logger™. The data is entered in the Sample Entry screen.

USGS Location

This variable combines the fields of <<Qtr Section Secondary>>, <<Qtr Section Primary>>, <<Section>>, <<Township>>, <<Township Direction>>, <<Range>>, and <<Range Direction>> to form a statement similar to:

NW 1/4 of SE 1/4 of Section 13, T. 26 N., R. 15 E.

The Well Logger™ variable for this field is <<USGS Location>>.

Water Encountered When Drilling

The Well Logger™ variable for this field is: <<Drilled Water>>.
Appendix A

Layout Forms
<table>
<thead>
<tr>
<th>Sample</th>
<th>Blow Counts</th>
<th>Completion</th>
<th>Depth Feet</th>
<th>Lithology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-2-3</td>
<td></td>
<td></td>
<td>5</td>
<td>SILTY SAND, very fine, medium brown, well graded, slightly moist.</td>
<td></td>
</tr>
<tr>
<td>8-14-23</td>
<td></td>
<td></td>
<td>10</td>
<td>SANDY GRAVEL, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.</td>
<td></td>
</tr>
<tr>
<td>8-10-21</td>
<td></td>
<td></td>
<td>15</td>
<td>SILTY GRAVEL, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.</td>
<td></td>
</tr>
<tr>
<td>5-8-15</td>
<td></td>
<td></td>
<td>20</td>
<td>SAND, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.</td>
<td></td>
</tr>
<tr>
<td>10-12-13</td>
<td></td>
<td></td>
<td>25</td>
<td>SILT, light brown, sandy, low plasticity, argillaceous.</td>
<td></td>
</tr>
<tr>
<td>46-48-50</td>
<td></td>
<td></td>
<td>30</td>
<td>SAND, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.</td>
<td></td>
</tr>
<tr>
<td>20-36-50</td>
<td></td>
<td></td>
<td>35</td>
<td>CLAY, dark gray to black, micaceous, hard, damp, NO ODOR.</td>
<td></td>
</tr>
<tr>
<td>42-44-49</td>
<td></td>
<td></td>
<td></td>
<td>CLAY, dark gray, micaceous, hard, damp, NO ODOR.</td>
<td></td>
</tr>
</tbody>
</table>

Completion Notes:
Schedule 40, 0.020” slotted PVC casing from 18 to 33 feet bgs; schedule 40, solid, PVC casing from 0 to 18 feet bgs; backfilled with no. 3 Monterey sand from 36.5 to 14 feet bgs and with hydrated bentonite grout from 1 to 14 feet bgs. Capped with concrete. Traffic rated 12” diameter locking well vault installed at the surface. Groundwater encountered at 23 feet bgs.

Site:
Your Favorite Project
1234 Your Favorite Street
Any City, Any State  01234

Project No.: 1234.56
<table>
<thead>
<tr>
<th>Sample</th>
<th>Blow Counts</th>
<th>Completion</th>
<th>OVA (ppm)</th>
<th>Depth Feet</th>
<th>Lithology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-2-3</td>
<td>240</td>
<td>5</td>
<td>SILTY SAND, very fine, medium brown, well graded, slightly moist.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8-14-23</td>
<td>40</td>
<td>10</td>
<td>SANDY GRAVEL, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8-10-21</td>
<td>320</td>
<td>15</td>
<td>SILTY GRAVEL, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5-8-15</td>
<td>300</td>
<td>20</td>
<td>SAND, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10-12-13</td>
<td>260</td>
<td>20</td>
<td>SILT, gray, clayey, some coarse sand, slightly plastic, stiff, moist, FAINT HYDROCARBON ODOR.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46-48-50</td>
<td>200</td>
<td>25</td>
<td>SAND, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20-36-50</td>
<td>0</td>
<td>30</td>
<td>CLAY, dark gray to black, micaceous, hard, damp, NO ODOR.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42-44-49</td>
<td>0</td>
<td>35</td>
<td>CLAY, dark gray, micaceous, hard, damp, NO ODOR.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Completion Notes:
Schedule 40, 0.020" slotted PVC casing from 18 to 33 feet bgs; schedule 40, solid, PVC casing from 0 to 18 feet bgs; backfilled with no. 3 Monterey sand from 36.5 to 14 feet bgs and with hydrated bentonite grout from 1 to 14 feet bgs. Capped with concrete. Traffic rated 12" diameter locking well vault installed at the surface. Groundwater encountered at 23 feet bgs.

Site:
Your Favorite Project
1234 Your Favorite Street
Any City, Any State  01234

Project No.:  1234.56
**Lithology Description**

- **SILTY SAND**, very fine, medium brown, well graded, slightly moist.
- **SANDY GRAVEL**, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.
- **SILTY GRAVEL**, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.
- **SAND**, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.
- **SILT**, light brown, sandy, low plasticity, argillaceous.
- **SILT**, gray, clayey, some coarse sand, slightly plastic, stiff, moist, FAINT HYDROCARBON ODOR.
- **SAND**, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.
- **CLAY**, dark gray to black, micaceous, hard, damp, NO ODOR.
- **CLAY**, dark gray, micaceous, hard, damp, NO ODOR.

**Completion Notes:**

Schedule 40, 0.020" slotted PVC casing from 18 to 33 feet bgs; schedule 40, solid, PVC casing from 0 to 18 feet bgs; backfilled with no. 3 Monterey sand from 36.5 to 14 feet bgs and with hydrated bentonite grout from 1 to 14 feet bgs. Capped with concrete. Traffic rated 12" diameter locking well vault installed at the surface. Groundwater encountered at 23 feet bgs.
SILTY SAND, very fine, medium brown, well graded, slightly moist.

SANDY GRAVEL, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.

SILTY GRAVEL, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.

SAND, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.

SILT, light brown, sandy, low plasticity, argillaceous.

SILT, gray, clayey, some coarse sand, slightly plastic, stiff, moist, FAINT HYDROCARBON ODOR.

SAND, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.

CLAY, dark gray to black, micaceous, hard, damp, NO ODOR.

CLAY, dark gray, micaceous, hard, damp, NO ODOR.
SILTY SAND, very fine, medium brown, well graded, slightly moist.

SANDY GRAVEL, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.

SILTY GRAVEL, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.

SAND, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.

SILT, light brown, sandy, low plasticity, argillaceous.

SILT, gray, clayey, some coarse sand, slightly plastic, stiff, moist, FAINT HYDROCARBON ODOR.

SAND, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.

CLAY, dark gray to black, micaceous, hard, damp, NO ODOR.

CLAY, dark gray, micaceous, hard, damp, NO ODOR.
SILTY SAND, very fine, medium brown, well graded, slightly moist.

SANDY GRAVEL, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.

SILTY GRAVEL, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.

SAND, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.

SILT, light brown, sandy, low plasticity, argillaceous.

SILT, gray, clayey, some coarse sand, slightly plastic, stiff, moist, FAINT HYDROCARBON ODOR.

SAND, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.

CLAY, dark gray to black, micaceous, hard, damp, NO ODOR.

CLAY, dark gray, micaceous, hard, damp, NO ODOR.
SILTY SAND, very fine, medium brown, well graded, slightly moist.

SANDY GRAVEL, very fine sand to fine pebble gravel, dark gray to brown, well graded, wet, FAINT HYDROCARBON ODOR.

SILTY GRAVEL, fine pebble gravel and silt with some sand, dark gray to brown, poorly graded.

SAND, very fine-grained, grading to silt, mottled: greenish gray to brown, subangular, poorly graded, note color change, FAIR HYDROCARBON ODOR.

SILT, light brown, sandy, low plasticity, argillaceous.

SILT, gray, clayey, some coarse sand, slightly plastic, stiff, moist, FAINT HYDROCARBON ODOR.

SAND, brown, fine-grained, well graded, wet, FAINT HYDROCARBON ODOR.

CLAY, dark gray to black, micaceous, hard, damp, NO ODOR.

CLAY, dark gray, micaceous, hard, damp, NO ODOR.
## Completion Patterns

<table>
<thead>
<tr>
<th>Completion Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bentonite</td>
</tr>
<tr>
<td>Bentonite, 1 Blank Casing</td>
</tr>
<tr>
<td>Blank</td>
</tr>
<tr>
<td>Concrete</td>
</tr>
<tr>
<td>Concrete, 1 Casing; 1 Blank</td>
</tr>
<tr>
<td>Hatch</td>
</tr>
<tr>
<td>Sand</td>
</tr>
<tr>
<td>Sand, 1 Blank Casing</td>
</tr>
<tr>
<td>Sand, 1 Screened Casing</td>
</tr>
<tr>
<td>Lithology Patterns</td>
</tr>
<tr>
<td>--------------------</td>
</tr>
<tr>
<td>ASPHALT</td>
</tr>
<tr>
<td>BRECCIA</td>
</tr>
<tr>
<td>CH - INORGANIC CLAYS OF HIGH PLASTICITY, ORGANIC SILTS.</td>
</tr>
<tr>
<td>CHALK</td>
</tr>
<tr>
<td>CL - INORGANIC CLAYS OF LOW TO MEDIUM PLASTICITY, GRAVELLY CLAYS, SANDY CLAYS, SILTY CLAYS, LEAN CLAYS.</td>
</tr>
<tr>
<td>COAL</td>
</tr>
<tr>
<td>CONCRETE</td>
</tr>
<tr>
<td>CONGLOMERATE</td>
</tr>
<tr>
<td>DOLOMITE</td>
</tr>
<tr>
<td>GC - CLAYEY GRAVELS, GRAVEL SAND-CLAY MIXTURES.</td>
</tr>
<tr>
<td>GM - SILTY GRAVELS, GRAVEL, SAND-SILT MIXTURES.</td>
</tr>
<tr>
<td>GP - POORLY-GRADED GRAVELS, GRAVEL-SAND MIXTURES, LITTLE OR NO FINES.</td>
</tr>
<tr>
<td>GRANITE</td>
</tr>
<tr>
<td>GW - WELL-GRADED GRAVELS, GRAVEL-SAND MIXTURES, LITTLE OR NO FINES.</td>
</tr>
<tr>
<td>LIMESTONE</td>
</tr>
<tr>
<td>MH - INORGANIC SILTS, MICACEOUS OR DIATOMACEOUS FINE SANDY OR SILTY SOILS, ELASTIC SILTS.</td>
</tr>
<tr>
<td>ML - INORGANIC SILTS AND VERY FINE SANDS, ROCK FLOUR, SILTY OR CLAYEY FINE SANDS, OR CLAYEY SILTS WITH SLIGHT PLASTICITY.</td>
</tr>
<tr>
<td>MUDSTONE</td>
</tr>
<tr>
<td>OH - ORGANIC CLAYS OF MEDIUM TO HIGH PLASTICITY, ORGANIC SILTS.</td>
</tr>
<tr>
<td>OL - ORGANIC CLAYS AND ORGANIC SILTY CLAYS OF LOW PLASTICITY.</td>
</tr>
<tr>
<td>PT - PEAT AND OTHER HIGHLY ORGANIC SOILS.</td>
</tr>
<tr>
<td>SC - CLAYEY SANDS, SAND-CLAY MIXTURES WITH OR WITHOUT GRAVEL.</td>
</tr>
<tr>
<td>SHALE</td>
</tr>
<tr>
<td>SILTSTONE</td>
</tr>
<tr>
<td>SM - SILTY SANDS, SAND-SILT MIXTURES WITH OR WITHOUT GRAVEL.</td>
</tr>
<tr>
<td>SP - POORLY GRADED SANDS, GRAVELLY SANDS, LITTLE OR NO FINES.</td>
</tr>
<tr>
<td>SW - WELL-GRADED SANDS, GRAVELLY SANDS, LITTLE OR NO FINES.</td>
</tr>
</tbody>
</table>
## Sample Patterns

<table>
<thead>
<tr>
<th>BLANK</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HATCH</td>
<td></td>
</tr>
<tr>
<td>SOLID</td>
<td></td>
</tr>
</tbody>
</table>